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Preface 

 

These are exciting times for the satellite remote sensing data 

processing and spatial data analysis. Gone are the days when 

access and availability of satellite data were limited. Similarly 

access to the platforms, software and packages were limited. 

Today, in the world of open and free access to data and 

software, using satellite data inputs are simply limited to 

browsing a web page. These web pages provide gateway to 

wider range of satellite remote sensing data.  

Having access to such database and platform is important for 

the students and researchers in low income and developing 

countries. These are also important for extraction of 

information for the rugged and inaccessible terrains like 

mountains. Researcher and Policy makers wish to quickly 

process satellite remote sensing data to extract information 

almost in real-time.  

One of the most challenging issues is capacity to access and 

process such datasets. This manual provides a Hands-on course 

on Basics of Satellite Data Processing for such group. The course 

document is prepared keeping the fundamental image 

processing techniques and satellite data processing in view so 

that anyone with a basic understanding of computers and 

interest in this field should be able to quickly learn through this 

document. Within the scope SUNRAISE Project, the document 

serves as an open course material so as to enable students, 

researchers, professionals and in-service people to learn and 

apply these tools to extract information from satellite remote 

sensing data.  
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INTRODUCTION TO SAGA 

 

Introduction  

 

SAGA (System for Automated Geoscientific Analyses) is an open-source digital image 

processing GIS program capable of processing images in different formats. It uses the 

well-established GDAL/OGR library to import and export images to and from its 

native format, SAGA Grid (*.sgrd).  

 

In this tutorial, we will use imagery from the Landsat 8 sensor. This image is a 

composite of 6 bands i.e. Band 1 (Blue), Band 2 (Green), Band 3 (Red), Band 4 (Near IR) 

and Band 5 and 6 (Shortwave IR). These are renamed bands and do not represent their 

actual band number in the raw satellite image. The image covers the city of Dehradun 

and its surround areas. In this tutorial we will learn how to handle, view and save 

raster data.  

 

SAGA is available as a stand-alone program which means it does not have an 

installation procedure. To start SAGA, navigate to the SAGA folder, look for the 

'saga_gui.exe' icon and double-click on it. The SAGA window will open. The different 

components of the window are given below. 
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We will start by opening an image in the program. To open the image, click on the 

'Load' button in the toolbar, or open it via the menu (File → Grid → Load)  

 

 
 

This will open a window from where we must navigate to our image folder. The images 

may not be immediately visible. At the bottom right of the window beside File name, 

there will be a drop down menu. Change the selection to 'Recognized Files'. Now, select 

„stack_sub‟ and click 'Open'. This imports the images into temporary *.sgrd images.  
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To see the list of these images, click on the Data tab under the Manager section. This tab 

displays all the data that has been loaded into SAGA. In SAGA, raster data is stored in a 

grid system. Each grid system contains images having the same pixel size, extent, and 

location. Accordingly, the default name of the grid indicates the pixel size, number of 

rows and columns, and the coordinates of the upper left most pixel. 
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In this case our image grid has:  

 

a)  a pixel size of 30 m.  

b)  351 rows and 263 columns  

c)  the coordinates of upper left pixel are (210450 x, 3348090 y)  

 

If you wish to extend the size of the any window, place your mouse over the edge of the 

window. When you get a double headed arrow, click and drag to the required extent  

 

To view an image, double-click on respective grid (for example: 'Band_4'). This will 

open the image in a window in the work area section. 

 

 
 

Note: If the image is not loaded in greyscale as shown below, you can set the greyscale 

color ramp by using: Settings Tab ColorsType: Graduated ColorsScalingClick 

on color ramp to browsePresetsSelectgreyscaleOKClick apply on Apply 

under Settings. 

  

To the right/left of the map window is the 'Object Properties' section, in which 

information about the image is displayed. The different tabs of this section are 

described below:  
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a)  Settings: Options related to the display of the data are found here.  

b)  Description: Description of the projection, geometry, extent, values and size of 

the data selected.  

c)  Legend: Displays the legend style of the data  

d)  History: Maintains a log of all the operations and changes carried out on this 

layer.  

e)  Attributes: This lists out the attributes of the selected data layer.  

 

You might notice that on opening the image, another toolbar appears. This is 'Map' 

toolbar, and it contains some basic tools used in layer navigation and display.  

 

 
 

Click on the 'Zoom' button and then click and drag on the map to zoom in to a 

particular area (Alternately, we may use the mouse scroll wheel to zoom in and out). 

Zoom to the pixel level where every pixel can be easily distinguished from its neighbor. 
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In the Object Properties section, under „Settings‟ tab there will be a field titled 'Show 

Cell Values'. Click on the check box next to it, and click on the 'Apply' button below.  

 

You will see that the pixels in the image are labeled with their Digital Number values, 

the higher values being lighter and the lower values being darker.  
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To move around the map, click on the 'Pan'  button and then click and drag the map.  

 

The current colour ramp of the layers is „greyscale‟. We may assign a different colour 

ramp by clicking on the 'Settings'  tab. Under the heading 'Graduated Color' is 

the entry 'Colors'. Next to this is the current colour ramp which looks like this 

. Select it and then click on the  button which appears on its right.  
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A Colors window appears, having 3 primary colour ramps which we can use to create 

our ramp. For now we will use a preset colour ramp. Click on 'Presets' and select 

'Rainbow' from the Preset Selection List and click „OK‟. Click 'Okay'. The settings of the 

layer will now look like this:  
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A Colors window appears, having 3 primary colour ramps which we can use to create 

our ramp. However, for now we will use a preset colour ramp. Click on 'Presets' and 

select 'Rainbow' from the Preset Selection List and click „OK‟. Click 'Okay'. The settings 

of the layer will now look like this:  

 

 
 

Click on the 'Apply' button located just above the 'Settings' tab. The image will now 

have the values colored according to the rainbow sequence, with blue for the lowest 

and red for the highest values.  
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Click on the 'Description' tab to view more information about the layer.  

 

Under 'Projection' is given the projection parameters. Our image uses the WGS 84 

Geographic Coordinate System. The identification code is EPSG 4326.  

 

Below this is the East-West extent of the image. The width of the image is given below 

that. We can check this using the tools given in the Map Toolbar.  
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Click on the 'Zoom to Full Extent' button of the toolbar to view the entire image again. 

Now click on the 'Measure Distance' tool. The mouse cursor will change to a '+' sign. 

Click the left edge of the image and then click the right edge of the image.  

 

We will now add all the images to a map window, select all the images in the list by 

hold down the CTRL key and click on each of the images (Alternately, you can click on 

the first image, press SHIFT and then click on the last image). Right-click on them and 

click 'Show'. A window will pop up asking you which map you wish to add the layers 

to. Select 'New' and click on 'OK'.  
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The Layers are stacked on top of each other, and therefore are only visible one at a time. 

To view a layer below the topmost one, right-click on it and click 'Show Layer'. The 

layer will become invisible, allowing us to see the layer below it. (We can also do this by 

just double-clicking on the layer). The invisible layers will be marked with a bracket like 

this  
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Another way to view a lower layer would be to right-click on it and select 'Move to Top' 

from the dropdown menu.  The layer transparency can also be changed by clicking on 

the „Settings‟ tab on the right and then clicking on the space next to „Transparency‟. 

Type in the required transparency (Set it to 100 to make the layer invisible) then press 

„Tab‟ in Keyboard. Click on „Apply‟.  

 
 

You may find that apart from the basic shapes, interpreting the image and the type of 

land cover is not possible by viewing it one band at a time. For this, we will need to 

view the image as a „true color composite‟ or „false color composite‟.  

 

SAGA cannot handle multi-band imagery. The layers have to be viewed individually. 

Therefore, for every band combination, a false colour composite must be created as a 

separate image, or must overwrite a previous image.  

 

Load the RGB Composite module via the Menu (Geoprocessing → Visualization → 

Grid → RGB Composite)  

 

The 'RGB Composite' window will open in which will assign a band to each of the 3 

colors. Click on the dropdown menu next to 'Grid System' and select the grid system to  

 

be used. Below this will be the entries for the colors. Using the dropdown menus select 

the appropriate bands for each colour. We will use the bands 4, 3 and 2 for Red, Green, 

and Blue respectively. Click 'Okay'.  
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The composite is loaded into the same grid system as the rest of the layers. Click on the 

Data tab and double-click on the layer titled 'Composite'. Add it into a new map. The 

composite will like below.  

 

If the Composite appears in grey ramp, go to the „Settings‟ tab, under „Colors‟ section 

select „Type‟ as „RGB Coded Values 
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16 
 

 
 

The composite makes it easier for us to interpret the image. For example, the red 

patches indicate the presence of vegetation, while the large cyan patched are built-up 

areas.  

 

To change the band combinations run the 'RGB Composite' module again. From the 

Menu select „Geoprocessing‟ and look at the last entry. It will display the most recently 

used processing module.  

 

Now save the project via the Menu (File → Project → Save Project As), In the „Save AS‟ 

popup window browse to the desired folder to save, and enter the desired name and 

click on „Save‟. In the popup window check the Checkbox „Save all‟ and click „Okay‟ 
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Task: Create RGB composites with 243, 254 and 324 combinations and describe the each 

composite usefulness over others to identify various land use/ cover. 
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DOWNLOADING SATELLITE DATA 

 

To visualize and download satellite data from USGS Earth Explorer 

 

The USGS EarthExplorer (EE) tool provides users to search, order satellite images, aerial 

photographs, and cartographic products from several sources like Landsat, Sentinel, 

Aster, MODIS, etc. In this tutorial, we will learn how to download Landsat 8 OLI 

satellite scene covering Jawaharlal Nehru University, New Delhi. 

 

Step 1: Look for EarthExplorer in the search engine or go directly to the link provided 

below. https://earthexplorer.usgs.gov/ 

  

 
 

Note: Remember in order to download satellite images; you are required to create a 

login account. No login details are required to visualize data. 

 

Step 2: Select a geocoding method. There are three ways to search area.  

 

a) Feature (GNIS) – Geographic Name information system. GNIS contains 

information about the official names for places, features, and areas in the 50 

states, the District of Columbia, and the territories and outlying areas of the 

United States, including Antarctica. 

https://earthexplorer.usgs.gov/
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b) Path/Row - It is an address developed by Worldwide Reference System (WRS) 

for Landsat data. Refer to the provided link for more information. 

https://landsat.gsfc.nasa.gov/the-worldwide-reference-system/ 

 

c) Address/Place – It searches places, locations, cities, etc. by their names.  

 

Simplest way is to go with „Address/Place‟ option first and if the tool is unable to 

search with the name, choose Path/Row (Latitude/Longitude of any location can be 

converted to Path/Row). Input full name of university in the Address/Place box and 

click on „show‟. 

 

 
 

Step 3: Define a particular range of area to be covered by the image. You can use a 

polygon draw a circle or upload a shapefile of the desired location. In this tutorial, a 

polygon is used to highlight JNU and its surroundings.  

Address bar 

https://landsat.gsfc.nasa.gov/the-worldwide-reference-system/
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Step 4: After selecting desired area, select the timeframe in the date range box. Move on 

to „data sets‟ after filling the required date. 

 

 
 

Step 5: Choose the data set you need from the list of data sets. In this case, we will select 

Landsat -> Landsat Collection 1 Level-1 -> Landsat 8 OLI/TIRS C1 Level-1. After 

selecting the data set, click on „Results‟. 

Step 3 

Step 4 
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Note: Explore additional criteria if required. It is not mandatory. 

 

Step 6: Result section will display the data sets available matching your criteria. Choose 

„show footprint‟ or „browse overlay‟ to check if the image covers your required 

area/polygon. 

 

 
 

Step 7: To download the image, click on „Download options‟.  Choose the type of image 

required for your study from the options.  

Step 5 

Show footprint 

Browse overlay 
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UNDERSTANDING AN IMAGE 

 

Introduction  

 

Satellite or airborne digital images are composed of a two-dimensional array of discrete 

picture elements, known as pixels. Generally, the pixels in remote sensing images are in 

square shape. The corresponding length of a side of the pixel on earth surface is known 

as ground sampling distance or simply „spatial resolution‟. Each pixel is associated with 

a spectral brightness value (also, known as Digital Number, simply „DN‟) of 

corresponding ground feature. These DN values are a quantized spectral radiance1 of a 

specific wavelength received at the sensor. The value range of Digital numbers in an 

image is determined by the radiometric resolution. For example, a sensor with 8-bit 

radiometric resolution permits maximum 28 i.e., 256 DN values (brightness values or 

gray scale levels) ranging from 0-255. A pixel with high DN value represents that the 

sensor received high spectral radiance from the corresponding ground area of the pixel 

and vice versa. In order to acquire sufficient spectral information of an objects on the 

earth surface, a set of sampling wavelengths in the electromagnetic spectrum are used. 

The sensor will record the DN values which are specific to these sampling wave 

lengths. Therefore, each sampling wavelength will result an array of pixels and is 

known as a band of satellite image. If a sensor uses one wider wavelength range (i.e, ≈ 

0.4 μm to 0.7 μm) to measure the spectral response characteristics of an area, then it 

records all the information into one single image band, such sensors are known as 

„panchromatic sensors‟ and the satellite image is known a „panchromatic satellite 

image‟. A multispectral sensor collects the spectral information using few number of 

sampling wavelengths in electromagnetic spectrum, hence it is a multi-layer (multi 

band) image. For example, Landsat-8 sensor records the spectral information in eleven 

image bands, for more information please refer 

http://landsat.usgs.gov/band_designations_landsat_satellites.php. 

 

 

The tutorial dataset is a stacked image of landsat 8, used in tutorial “Introduction to 

SAGA”. OR you can use the dataset you have just downloaded in the previous exercise. 

 

To view image bands double click on the Image bands under „Data‟ tab in „Manager‟ 

section. In order to open them in separate viewers, make sure to select option „New‟ in 

„Add layer to selected map‟ window when it prompt. And change the colour ramp to 

grey scale (Refer: previous tutorial) 

http://landsat.usgs.gov/band_designations_landsat_satellites.php
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Before proceeding further, tile the viewers via, „WindowsTile Horizontally. And 

synchronize the extents via, MapSynchronize Map Extents. 

 

 
 

Sub-setting using polygon 
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Add the shapefile to same layer as the raster image to see its location on the satellite 

data. 
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If a grey scale (Black to white) colour ramp used to represent the image. Then black 

colour represents less, grey colour represents medium and white colour represents high 

spectral returns from the earth surface features. Zoom to various land-cover classes i.e., 

water, urban areas, and agriculture etc., and try to explore the brightness values (DN) in 

terms of spectral response of land-cover classes for the individual bands. Write down 

the relative spectral response as „low‟, „medium‟ or „high‟, for the different land cover 

classes and spectral bands. 

 

 Forest Built-up area Agriculture 

Band 2    

Band 3    

Band4    

Band5    
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Green cover 
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Built-up areas 

 
 

Agriculture 
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Band Statistics  

The distribution of brightness values (DN values) in a single band can be represented 

graphically using a histogram. The correlation between two (or more) bands can be 

assessed graphically by using a scatter plot. Large negative values indicate a strong 

negative correlation where as large positive values indicate strong positive relation and 

covariance values near to zero indicate no correlation. In this section, we will explore 

the image band data characteristics by using graphical methods.  

 

Graphical Representation  

Histogram  

The study of histogram provides initial information about the most important 

parameter of an image, i.e., contrast. Histogram is a frequency distribution function of 

DN values, which provides the information about number of pixels having a particular 

Digital Number. It can describe an image just in statistical terms without even 

explaining its spatial patterns.  

 

Histogram can be calculated for each band by just right clicking on the image band 

under Data Tab in Manager section, and select „Histogram‟. A new window will popup 

showing the histogram of the image band selected.  

 

You can zoom in or out of the histogram extent using scroll key of mouse and also by 

dragging mouse with left data button and reset by right data button of mouse  
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Follow similar steps to open up histogram for rest of three bands. Open four windows 

simultaneously side by side to see the frequency distribution of DN values in each 

band.  

 

All the four image bands cover the same area with same extent. However, you can see 

different shape and sizes of band histograms. As explained earlier these differences are 

due to objects ability to respond differently with different spectral wavelengths.  

 



31 
 

 
 

A scatterplot is simply a graph of the DN values of one band plotted against the DN 

values of another band. If the DN value in the image bands follows normal distribution, 

then the corresponding feature space of scatterplot will form an ellipse. The feature 

space in scatter plot is very useful to select the training samples and also helpful to for 

principal components. In a Bi-dimensional scatterplot, the Cartesian axes (X, Y) 

represents the Digital Numbers of the two bands in interest, Z axis represents the 

frequency of occurrence of certain phenomenon. In this section we will learn how to 

construct scatterplot.  

 

Right click on Band3 under Data tab in Manager section and select Scatterplot. It will 

prompt a new window, now select options as shown in below figure and click „OK‟.  
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Scatter plot of band 4 with band 4 is displayed. 
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Scatter plot of Band 4 with Band 3 

 

 
 

Now you can see the scatterplot of Band 4 vs Band 3 in a map layout. The X axis of 

scatterplot represents Band 3 while y-axis represents Band 4. It also gives the regression 

equation between the two bands along with correlation coefficient.  

 

We can compute the scatter plot data in form of table. Goto „Menu 

barScatterplotConvert to Table and have a look at mean, minimum, maximum, 

standard deviation values using the description table of object properties window.  
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IMAGE PRE-PROCESSING 

 

Atmospheric Correction  

 

Top of Atmosphere correction converts Landsat imagery reflectance by removing 

variation due to solar irradiance. Load band 2-4 of the data provided to you in the 

folder L7. Then go to  

 

Geoprocessing>Imagery>Landsat>Top Of Atmosphere Reflectance 

 

 
 

 

 
 

Enter the bands you wish to correct tool the will automatically create corrected bands. 
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 Load the metadata.txt file that comes with Landsat scene downloads (This contains 

TOA correction details). Make sure you have the right Landsat sensor selected. 

 

Open band 4 of the raw data and the reflectance data in different map windows, zoom 

in to pixel level and synchronize map extents. Check show cell values in the settings tab 

and compare. Notice that DN values of the original image is in 8 bit format and will 

range from 0 to 255, whereas cell values of the data will range from 0 to 1. 

 

 
 

Calculating Vegetation Indices  

 

A variety of algorithms have been developed by researchers in an attempt to extract the 

most information from the satellite image spectral bands. Many of these are vegetation 

indices used for monitoring and mapping vegetation vigour. SAGA allows the 

automated calculation of a number of these. 

 

Geoprocessing>Imagery>Vegetation Indices 

 

The example shown below is using the Vegetation Index (Slope Based). Simply enter 

the Red and Near Infrared bands (4 and 5 for Landsat 8) and select <create> for the 

index you would like to calculate. 
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You will see all the new band combinations/indices in the data tab: 

 

 
 

Displaying one of the vegetation indices as green as a rainbow display really highlights 

the distribution of actively growing (high photosynthetic activity) vegetation as shown 

in the image below. Red areas indicate higher NDVI values represented by greener 

areas which are mostly forest or agriculture land. Blue areas indicate lower NDVI 

values as represented by built-up areas and river bed etc. 
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To find out the meaning of all the different vegetation indices and how they might be 

interpreted you can view further information if you select the vegetation index module 

in the Tools tab and select the description tab. As shown below it provides a description 

of the algorithms used to calculate each indices and references to more information. 
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Reprojecting toposheet or raster 

 

Load the DEM data. This has units in degree. It is in a geographic coordinate system 

(Lat/Long). 

And the projection system is GCS WGS 84.  

 

Load the shapefile data provided. This file is in a UTM (Universal Transverse Mercator) 

projection. 

 

 
 

Reprojecting the ASTER DEM data to a UTM projection will also allow us to combine it 

with the UTM polygon file. To reproject first set the projection of the current data set.  

 

Right click on the ASTER DEM grid layer and select spatial reference: 
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Set the spatial reference to the WGS 84 geographic coordinate system as shown below: 

 

 
 

We can now re-project the elevation data into our UTM zone (44N).  

 

Geoprocessing > Projection > Coordinate transformation Grid  
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In the module dialogue window:  

1. Enter the ASTER DEM grid to be projected  

2. Set the resampling to “Nearest Neighbour”  

3. Set the Projected Coordinate system to UTM Zone 44N.  

 

 
A new dialogue box will appear where you can set the output cell size. For standard 

ASTER DEM data this should be 30 metres. 

 

 
 

 
 

You should now be able to display the mask boundary vector data over the top of the 

new reprojected elevation file. 
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You will be able to notice a slight tilt in the DEM data due to projection transformation 

and now the scale is in kilometers and not degrees. 

 

Add the mask shapefile to the same map window. 

 

To view the grid data under a polygon file set the fill style to „Transparent‟ in the display 

settings tab. 

 

Vector layers can also be re-projected following similar steps and using Geoprocessing> 

Projection>Coordinate Transformation (Shapes). 
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Image subset using a raster Grid 

 

Load both the datasets as well as panchromatic band of L7 data as learnt in earlier 

tutorials. 

 

 
 

Display band 4 of stack_sub and band 4 of landsat 7 data using Add to Map option and 

tile horizontally from window tab 
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We will clip the Landsat 7 data same as the extent of stack_sub. 

Go to Tools>Grid-Tools>clip grids 

 

And set the values as given below 

 

 
 

 
 

Add band 4 of the new clipped raster to the same window as landsat 8 data. You can 

see the subset added to its location in the original data. 
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You can change the symbology to greyscale as described in previous tutorials. 

Similarly, clip panchromatic band (15m) also. 

 

Image Sharpening 

 

 
 

Enter the 30-metre bands you wish to sharpen and the band 8 grid for the high-

resolution band. 
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Now display the new band 543 grid (15m) as well as 30m band 543 grid as a band 

composite image to compare the resolution difference. 

 

 
 

Zoom to a closer level and examine the changes. 
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15m composite has enhanced visualization for smaller features like settlements which 

were not separable in 30m composite.  

 

Try other image sharpening algorithms also other this procedures. 
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FILTERING AND ENHANCEMENT 

 

Images come in varying levels of quality and information. Using filters, we can remove 

the noise from an image, making it fit for analysis and interpretation. Sometimes, even 

having high quality images may not be enough, to glean more specific information it is 

necessary to process it with various algorithms. Generally, Kernel filters are used to 

accomplish these tasks. A kernel filter uses a moving window that processes each pixel 

value taking into account the values of the neighboring pixels. They may be used to 

highlight/suppress specific information in the image.  

 

In this tutorial we will learn to use different filters to perform some basic enhancements 

on „subset of a Landsat 8 image and „Land use and Land Cover Classification‟ images. 

 

1.  Start SAGA GIS and open the image by clicking the ‘Load’ button and navigating 

to the folder containing the tutorial data to open the file named „stack_sub‟.  

 

2.  The image is loaded in the tab list. Double click on it to open it. 

 

 
 

Low-Pass (Smoothing) Filter: This filter is the most basic filter used for smoothing an 

image. It blurs the small features by taking the average of the center pixel and the 

neighboring pixels. The new value of the pixel depends not just on the original value 

but on the neighboring pixels as well. Thus, by suppressing the starkness of the central 

pixel it blends in with the rest of the pixel neighbors. It is called a ‘Low Pass’ filter 

because it passes the features of low spatial frequency while removing the high 

frequency features. 
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Open simple kernel filter via, Menu → Geoprocessing → Grid → Filter → Simple Filter. Set 

the „Grid System‟ and „>>Grid‟ to the current image (i.e., stack_sub) and Change the 

„<Filtered‟ Grid output to [create]. If this is ‘[not set]’ then the output would overwrite the 

original image. The options are explained below:  

 

Search Mode: This is the shape of the kernel window. The default is Circle. Change it to 

‘Square’.  

Filter: This tells us which type of filter we are applying to the image. Since we are doing 

a smoothing of the image, we will use the ‘Smooth’ option.  

Radius: The radius describes the size of the kernel window. The value 1 represents a 

kernel size of 3x3 pixels. If the value 2 represents 5x5 and so on. For now, we will use 

the value 1. Click „Okay’. 

 

    
 

Open the filtered image in a new map window by double-clicking on it in the list under 

„Data‟ tab. In the popup window select ‘New’ and click ‘OK’.  
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Change the color symbology of the filtered image from 

colorpresetgreyscaleOkayApply 
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Tile the viewers from WindowsTile Horizontally 
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Select the first map window and synchronize their extents via, Menu → Map 

→Synchronize Map Extents). Click the  ‘Action Tool’ button, ‘zoom in‟ to Individual 

pixel level as shown below, and select a few pixels. From the tab, check 

and click ‘Apply’.  

 

You can change the name of the output image in the „Name‟ section, press „Tab‟ from the 

key board and click „Apply‟. 
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56 
 

 
 

 

As we see above, the central pixel on the left gets smoothed to more closely resemble its 

neighbors.  

 

High-Pass (Sharpening) Filter: A sharpened image is one in which the smaller features 

are made more prominent. They appear sharper when each pixel can be differentiated 

from its neighbouring pixels. To do this, we must heighten the difference between a 

pixel and its surroundings. The High-Pass filters often treated as Edge detection or 

Directional filters. 

 

Go back to the Simple Filter module and change the ‘Filter’ option to „Sharpen’. Change 

the output ‘Filtered Grid’ to „[create]‟. Click ‘Okay‟ (Refer step 4). Open the image in a 

new window and set its color scheme to Greyscale.  
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The filtered image (2nd image) has more sharp edges than the raw image. 

 

Edge Detection using the Laplacian-of-Gaussian filter combination: This combination 

of the Laplacian-on-Gaussian filters is used for sharpening images while preventing the 

amplification of noise. A Laplacian filter on its own would amplify the noise in an 

image. 

However, if we preprocess it with a Gaussian filter, the noisy pixels get smoothed out. 

This reduces the chances of noise amplification.  

 

Open the Laplacian Filter module via Geoprocessing → Grid → Filter → Laplacian Filter. 

Set the options as given below. Ignore the options under ‘User Defined Kernel’, since we 

are using the ‘Standard Kernel 2’ and click „Okay’.  
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This will create an edge filter which highlights all the edges in the image. An edge is 

signified by an abrupt and sudden change in pixel values. This allows us to identify the 

boundary of features easily.  
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To reduce the amplification of noise we will first pass a Gaussian filter over the image. 

Open the module via Geoprocessing → Grid → Filter → Gaussian Filter. In the filter 

window, set the options as shown below. For now we will use the default options. Set 

the output ‘< Filtered Grid’ to ‘[create]’ and click „Okay‟. Change the colour ramp to 

original image. And tile horizontally 
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Now, pass a Laplacian filter on this Gaussian smoothed image (output of step 13) 

referring step 10 and below figure. 
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MOSAICKING 

 

Introduction 

 

Satellite imageries come in varying swath widths, depending on their source of 

acquisition. For example, the LISS-3 imagery is approximately 140 Km swath width 

while the Landsat TM imagery covers 185 Km, and SPOT imagery is just 60 Km swath 

width. These images cover large swathes of land but in most of the cases the Area of 

Interest (AOI) is not covered by a single satellite image. We need to assemble the 

satellite images which cover the individual parts of AOI to form a single composite. 

This composition process is known as „Mosaicking‟, it requires very accurate 

radiometric and geometric corrections to the constituent imageries (Rees, 1999). 

Sometimes, for management or other reasons, only a part of the entire image needs to 

be displayed or processed to convey the information or to represent the whole. 

Therefore, it becomes necessary to extract the area of interest from the images/ mosaics, 

and this extraction process is known as „Subsetting‟. In some software packages it also 

called as Extract, Clip or Cut. 

 

In this tutorial, you are supplied with four images of ASTER DEM (30m spatial 

resolution) of a part of Uttarakhand. The objective of this tutorial is to provide hands on 

guide to mosaic and subset the satellite images. For mosaicking a multi-spectral satellite 

image, same procedure needs to be followed and applied on each band individually. 

 

Load the images in SAGA by clicking on the „Load‟ button. In the window that pops up, 

navigate to the tutorial data. The layers may not be immediately visible, so change the 

dropdown menu selection from „All Recognized files‟ to „All files‟. Select all the four 

files and click „Open‟. 

 

The layers are imported into SAGA now and can be seen in the tab of the Workspace 

window. They have a slight overlap. We will have to mosaic them. 
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Start mosaicking the image by clicking on Geoprocessing → Grid → Grid System→ 

Mosaicking. This will open the Mosaicking window. In the field „Input Grids‟ click on 

the button. A window called „Grids‟ will open in which we select all the 4 layers and 

click on the button to send them to the right part of the window. This means that all the 

images will be mosaicked. Click Okay. 
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In „Mosaicking‟ windows, change the resampling to „Nearest Neighbor‟, Overlapping 

Areas to „blend boundary‟ and leave the Target Grid to User Defined and Click „Okay‟. 

Another window appears showing the Mosaicking options. Click „Okay‟. 

 

 
 

The merged grid will appear in a separate grid as „Mosaic‟ under Data tab. We can 

remove the original images from the data list by right-clicking on their grids and 

selecting „Close‟ (Click on „Yes‟ and „Close‟ in the successive prompt windows). 
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Right-click on an image and select „Add to Map‟. The full image will have opened up in 

the Map Area 

 

 
  

Change the color of the mosaicked image to greyscale by referring to earlier tutorials. 
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UNSUPERVISED CLASSIFICATION 

 

To create a land use and land cover map of an area, we have to assign corresponding 

land use and land cover type to every pixel in the satellite imagery that exist at the time 

of acquisition. This is done based on the Digital Number (DN) values of the pixel which 

in turn represent the spectral properties of the ground surface. This assigning of classes 

to pixels in an image is called „Image classification‟. More technically, it is an aspect of 

image processing in which quantitative decisions are made on the basis of the data 

present in the image, grouping pixels or regions of the image into classes representing 

different ground-cover types. The output of the classification stage may be regarded as 

a thematic map rather than an image (Rees, 1999). Two broad types of image 

classification exist – „Supervised classification‟ and „Unsupervised classification‟. In this 

tutorial we will learn how to classify an image using the unsupervised method.  

 

In unsupervised classification, the algorithm analyzes all the bands of the image and 

pick out the clusters of pixels having similar values without the user intervention. The 

clusters are then assigned to their classes at the user‟s discretion. Therefore, this method 

generally applied to the regions, where we don‟t have any knowledge and information 

about land cover type. In this tutorial, we will use a stacked image with bands 2 to 7 

(labelled as 1 to 6) of Landsat 8 to create a land cover map of Dehradun and its 

surrounding region. 

 

Load the Landsat image into SAGA by clicking on the „Load File‟ button or via File → 

Grid → Load. Select the „stack_sub‟ image. This will import the image into SAGA.  
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Since different features are not easily identifiable in single band image, we will prepare 

a FCC composite for the same. The steps are given below. 

 

 
 

 

 



70 
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Change color type from graduate colors to RGB to visualize the composite in FCC. Go 

to windows and tile horizontally. 
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Now we will classify the image using Geoprocessing → Imagery → Classification → 

Unsupervised → Cluster analysis for Grids (ISODATA). Select all bands and move to 

the right and click okay. 
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The module window options are explained below.  

 

Grid System: This is grid system of the image to be classified. Select it from the drop-

down menu. 

  

>>Features: These are the input grid layers that will be used in the classification. Click 

on the button and select the Landsat layer/s and click on the button and click on 

„Okay‟.  
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<<Clusters: This is the output option for the clustered image. To create a new image, we 

keep it as „[create]‟. If we are running the cluster analysis for the second time and want 

to overwrite an image then select the image to be overwritten from the dropdown 

menu. 

 

<<Statistics: This creates a table with the statistics of the band layers and the clusters. By 

default, it is set as „[create]‟ but we can overwrite an existing table by selecting it from 

the dropdown menu.  

 

Options: Specify the options as shown below  

 

 
 

On clicking „Okay‟, the cluster analysis will start and will keep reiterating the search. 

You can see the progress on the left side of the status bar located at the bottom of SAGA 

GUI.  

 

The classified image titled „Clusters‟ is placed in the Landsat image grid system. Double 

click on it to open in the „True Colour Composite‟ map list.  
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This newly created cluster map splits the image area into homogenous land cover 

segments. We now have to assign each cluster to its land cover class.  

 

Before doing that we have to assign a unique number to each land cover class. We will 

use a simple 5 class classification. You may use the ones below or select your own.  

 

Insert table 

Class number Class Name 

1 Dense Forest 

2 Open Forest 

3 Agriculture 

4 Non-Forest 

5 River Bed 

 

Now turn on and off the cluster layer in the Map window. You will see that the clusters 

take the shape of some land features. This way we can identify the clusters based on 

their shape, location and image pixel values.  

 

Select the „Clusters‟ layer from the data list and click on the tab. This will display the 

different class numbers and their associated colour. To check which cluster a pixel 

belongs to, just mouse over the pixel and look at the Status Bar at the bottom of the 

SAGA window. This displays the „Z value‟ of the pixel. In this case the Z value is the 

class number.  

 

We will start assigning class numbers to the clusters by selecting the layer and then 

accessing the tab. Click the button under „Table‟ to open the lookup table. This will give 

the clusters information with five fields: COLOUR, NAME, DESCRIPTION, MINIMUM 

and MAXIMUM.  

 



76 
 

 
 

The color of a cluster can be changed by clicking on it and choosing a color from the 

palette. The MINIMUM and MAXIMUM fields indicate the cluster number and will 

have the same value in this table. The numbering of the clusters starts from 0. Therefore, 

Class 1 would be numbered 0, Class 2 would be numbered 2, and so on.  

 

Identifying classes and the land cover they represent can become difficult when looking 

at the cluster map with all its classes. To make it easier, we will handle them one at a 

time.  

 

Tile both the RGB and the unsupervised classification output. In the attribute table turn 

all the layers as white and give color to a class one by one and identify the type of land 

covered by this cluster using the false color or true color composites. For example, let‟s 

look at the first cluster. 
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We see that the cluster covers „Dense forest‟ land cover. So, we mark in the NAME 

column as „Dense Forest‟ and color to „dark green‟. 

 

Go to the next cluster below and Change its colour to „Yellow or some other bright 

color‟. Click „Okay‟ and then „Apply‟. The next cluster will now be visible. Repeat the 

same procedure. 

 

Repeat the last two steps till all the clusters have been assigned a class number. 
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The final classified image looks like this. 
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SUPERVISED CLASSIFICATION 

 

In the previous tutorial, i.e.: „Unsupervised Classification‟, we classified the images 

using the unsupervised method. There are limitations in using this method since we 

don‟t have full control over the computer‟s selection of pixel into clusters. In supervised 

classification, the user will select a group of pixels belongs to a particular land use / 

land cover known as training areas or training sites. Based on the pixel values in the 

training areas the software will create spectral signatures and the statistical information 

like range, mean, variance etc., of all classes in relation to all input bands. This 

information has been used to categorize each and every pixel in the image into 

corresponding land use and land cover class based on the classification algorithm used. 

Maximum Likelihood (ML), Minimum Distance to Mean (MDM) and Parallelepiped 

classification algorithms are most commonly used for supervised classification. For 

brief introduction about the algorithms please read section 8.3.4 „Classification 

algorithms‟ in Principles of remote sensing: an introductory textbook of ITC, 2009.  

 

Since, the supervised classification method involves selection of training areas, the user 

should have a good idea about different land cover classes existing in the study area. 

This knowledge can be acquired through field verification and other ancillary data. In 

this tutorial we will use the same Landsat 8 image supplied to you for unsupervised 

classification. This image was downloaded from the USGS earth explorer website: 

http://earthexplorer.usgs.gov/  

 

1. Open SAGA Interface → Load the Landsat images into SAGA by clicking on the 

„Load File‟ button or via „File → Grid → Load‟. Select the „stack_sub‟ images and click 

„Open‟. This will import the image into SAGA.  

 

In SAGA, the sample collection is done by using shapefile polygons. Create a shapefile 

layer via the „Geoprocessing → Shapes → Construction → Create New Shapes Layer‟. 

Enter „signature_samples‟ in the „Name‟ field and change the Shape Type to „Polygon‟. 

Leave the default values in the other three fields. Click „Okay‟.  
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A polygon named „signature_samples‟ will be created and placed in the „Data‟ list 

under the Shapes. Add this polygon layer to the map (False color composite) on which 

you would like to create the sample polygons by double clicking on the 

„signature_samples‟ shape file → Now select „stack_sub‟ from the popup window i.e., 

„Add layer to selected Map‟ → „OK‟.  

 

In order to pick up training areas, we have to enable the editing mode of shape file. To 

start editing, Right-click on „signature_samples‟ shapefile → Edit → Edit selection or 

Select the Action button from „Tool Bar‟ or from „Main menu bar → Map → Action‟ and 

then Right click on the map → Add Shape. This will change the cursor to a „+‟ sign.  

 

Zoom in to the forests in the left of the image. Create the sample shape by clicking 

around a bright red forest patch. When you are outlining be precise to select as many 

similar looking pixels as possible within a single polygon.  
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The signature sample is listed in the polygon attribute table. To open the attribute table: 

„Right-click on polygon layer → Attributes → Show‟. The attribute table will open with 

two fields – ID and Name. By single / double click on the corresponding cell you can 

able to change vales in table. Type the name as „Forest‟. The ID field is filled in as 0, 

change this to the corresponding class number as per the following table below. For 

„Forest‟ the corresponding ID is „1‟.  

 

Class Number Class Name 

1 Forest 

2 Agriculture 

3 Built-up 

4 River bed 

 

 
 

Note: While creating sample shapes, draw the boundary on the inside edge of a feature. 

This will ensure that a purer signature is picked up from this sample. Make sure that a 
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signature contains only pixels of the interested land cover/use class. If other class pixels 

are present it will dilute the quality of the signature. 

 

A few things to keep in mind while digitizing the signatures in SAGA:  

 

a. The Right-click → Edit operations may not always work via the Maps tab and the 

Map Window. At this time you have to select Action tool before doing it again.  

b. If you notice no tool bar on the under main menu, which contains Action, Zoom, Pan 

and other tools, click on Map window to access them.  

 

We must therefore pickup signature for every variation of forest for accurate 

classification. Zoom in to the shaded forest, then select „Forest‟ row from the attribute 

table. Be sure that the row is highlighted in blue color and as well as the first Forest 

polygon in yellow. Now navigate to the forest area in shadow, looks Dark red in false 

color composite formed in previous step in the map window.  
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Now, click on Action and then right-click on the Map → select „Edit Selected Shape‟→ 

You can notice the first forest shape changed in to editing mode →Once again right-

click on the Map → Select „Add Part‟ → create a signature for forest area in shadow as 

well → „Right click‟ to finish the polygon. Repeat this process to cover all variations of 

forest. Save the shape by Right-click (once/twice) → Uncheck „Edit Selected Shape‟. 

Now you can see that all forest variations are add to the same signature „Forest‟.  

 

Similarly use Add Shape option to create a new land cover / land use class and „Add 

part‟ option to pickup variation of it. Now collect signatures for the rest of the classes 

presented in the table under previous steps.  

 

Once you are done with the signature collection, now you are ready to run Supervised 

classification module. Open it via „Geoprocessing → Imagery → Classification → 

Supervised Classification‟ module. Set the values for Grid system, Grids, Training Areas 

and Class Identifiers as shown below.  
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The „Grid system‟ entry will be the grid system of our input data set. For the  

 

a) >>‟Feature‟, click on the button to the right of the field. In the dialogue popup 

window, we select the Landsat Image and click on the button. This will transfer 

the layers to the right which indicates that they will be used by the module. Click 

„Okay‟.  

b)  „>>Classification‟ as „[Create]‟. The Quality option allows us to create an image 

which describes the quality of the classification for every pixel. The image values 

vary with the type of classification, here will select „[not set]‟.  

c) „>>Training Areas‟ input is the shapefile containing all the signature shapes. Set 

it as „signature_samples‟.  

d) The „Class Identifier‟ is the field with which we differentiate the classes. The 

classes will be named according to this field. Set it as „ID‟ or „Name‟. By using 

this text field, we can easily identify and relate the sample area description with 

the class.  

e) Set the Method option as „maximum likelihood‟ and leave others as default.  

f) Click on „Okay‟ to proceed for maximum likelihood supervised classification.  

 

The classified image will look something like the image below. The image has been split 

into 4 classes, with each class coming from one set of signature polygons.  
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We can assign colors and class names via the lookup table. Select the image from the list 

and open the lookup table by clicking the button via the tab  

 

 
 

The lookup table will open with 5 columns - COLOUR, NAME, DESCRIPTION, 

MINIIMUM, and MAXIMUM. Click on the color box and select a color from the palette 

or create your own. Click on „Okay‟ and then „Apply‟ in the tab.  
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There may be parts of the image which are wrongly classified. This mostly happens if 

the signature of one class is similar to that of another class. This can be fixed by refining 

the signatures and run the classification again. For example, in the classification below, 

the built-up pixels have been wrongly classified as river bed. Compare the picture on 

bottom to the satellite image on the top. We may rectify this by creating signatures 

samples from these pixels and then classifying them as built-up.  
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Accuracy assessment 

Load the classified image (Classification [Maximum Likelihood]) and the satellite data 

(stack_sub) as learnt in previous exercises. Open the satellite data in RGB composite in a 

new map window and classified image in another map window. Tile the two map 

windows vertically from WindowTile Vertically. 

 

Click on the classification image in data tab and change the „colors‟ type option in the 

settings tab from graduated colors to look up table. Now check the look up table in the 

settings tab. It should resemble the following 

 

 
 

The classification image is classified into 4 classes. 

 

Class Class Name 

1 Riverbed  

2 Forest 

3 Built-up 

4 Agriculture 

 

Accuracy assessment in SAGA GIS will involve four basic steps. 

a) creating random points 

b) extracting values of the classifies image at these randomly generated points 

c) filling reference values of these points from the satellite image. 

d) computing accuracy assessment parameters using confusion matrix 

 

Go to ToolsShapesGrid Tools Grid value to points (randomly). 
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Fill in the parameters as shown below. 

Grid should be your classified image, you can try playing with the frequency option, 

decreasing the frequency value will increase the number of points generated. A value of 

1500 seemed optimum for the size of our data set and generated a point shapefile with 

56 points. 

 

 
 

Right click on the point shapefile in the data tab and open the attribute table as shown 

below 
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Here value represents the class in which individual points are classified. 

We need another column to fill in our reference values from the classified image. For 

this go to ToolsShapesGrid ToolsAdd grid values to points 

 

 
 

In the points, select point shapefile created in the previous step and grids is the 

classification image, choose rest of the options as displayed above and click okay.  This 

will create another point shapefile. Open its attribute table by following the steps 

described earlier. 
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This will add another column to the table with values of the class of each point. Right 

click on this point shapefile and open it in the same map window as the satellite image 

by add to map option. In the attribute table of the point shapefile, double click on the 

first row. This will select the point with ID 1 in the map window. Zoom to that location 

and make a guess as to in which class this point should have been classified and fill the 

class number in column three. Repeat this for all the remaining points. Your final table 

will now contain class values in the “value” field and reference values in the 

“[Maximum” field. Close the attribute table. 
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Right click on the edited point shapefile and save as .txt file. 

 

Open this .txt file in excel and it should look like this 

 

 
 

Value column is your class value and classificat is your reference column. 

We will now make the confusion matrix for the 4 classes.  

 

 1 2 3 4 

1     

2     

3     

4     

 

Make a matrix in your excel file as shown above.  

Diagonal matrix elements represent the correctly classified pixels. For eg. 1,1 represent 

the number of testing samples which were classified as class 1 and also belong to class 

1. Similarly,for 2,2 etc. Whereas matrix element 1,2 represent number of testing samples 

which are classified in class 1 but actually belong to class 2. 

 We will now calculate these values using “countifs“ function in excel. 

In matrix element 1,1 , type this command. This will provide the number of vlaues in 

“value” field which is equal to „1‟ and is equal to „1‟ in the „classificat‟ field also. 



93 
 

Meaning all the testing samples which were classified as 1 and actually belong to class 

1.  Here column B is the class value and C is the reference value.  

=COUNTIFS(B2:B57, "=1",C2:C57, "=1") 

 

 
 

In element 1, 2, 

=COUNTIFS(B2:B57, "=1",C2:C57, "=2") Meaning all the testing samples which were 

classified as 1 and actually belong to class 2.   

Similarly we compute the values for all matrix elements. Sum all the respective rows 

and columns. The total sum of rows and the total sum of columns will be equal to 56 

which is the total number of testing samples collected. Here is an example. 

 

 1 2 3 4 Row Total 

1 0 0 6 0 6 

2 0 26 0 2 28 

3 0 0 15 6 21 

4 0 0 1 1 2 

Column 

Total 

0 26 22 9  

 

Overall Accuracy= ((sum of all the diagonal elements*100)/ Total sum of all the 

elements)   
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This will range from 0 to 100% 

Producer‟s Accuracy (PA) for each class = (Diagonal element or correctly classified 

samples/Column total for that class)*100 

 

User‟s Accuracy (UA) for each class = (Diagonal element or correctly classified samples 

/Row total for that class)*100 

 

For instance, in the example above, for class 2, 

PA= (26/26)*100=100% 

UA= (26/28)*100=92.85% 

 

Similarly calculate for other classes also. 

Compute the total number of agreements by summing the values in the diagonal cells 

of the table 

Agreement (A)= 26+15+1 =42 

Expected frequency for each class (E) = (row total*column total)/ total number of 

testing samples 

Eg. For class 2, Expected frequency = (28*26)/56=13 

 

Calculate sum of E for all the classes. 

 

Kappa= (Sum of all the diagonal elements (A)- Sum of E for each class)/(Total number 

of testing samples-Sum of E for each class) 

 

Calculate this yourself!! 
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CHANGE DETECTION 

 

Introduction  

 

Change detection enables us to assess the gains and losses among various types of land 

use and land cover in a region over a period of time. Remote sensing data is widely 

used for change detection due its high temporal resolution, wide coverage and cost 

effectiveness over field surveys/inventories. Change detection can be used as 

diagnostic tool to understand the impact of anthropological effects on natural resources, 

which might further help us to prepare a sustainable planning measure to protect our 

environment. Change detection techniques are mainly of two types. The first one is 

spectral change detection, in this technique the unit of analysis is a pixel, a 

neighborhood, a multi temporal segment or a spectral class (Campbell & Wynne, 2011). 

One would require accurate radiometric, atmospheric and geometric corrections to be 

carried out before performing the spectral change detection. The second technique is 

post-classification change detection. It uses thematic maps (classified images) as inputs. 

It is a relatively easy and less accurate method compared to spectral change detection. 

In this tutorial we will learn how to perform post-classification change detection in 

SAGA.  

 

In the supervised and unsupervised classification tutorial, we learnt how to create 

thematic maps from satellite images using different image classification techniques and 

how to assess their accuracy. These images serve as excellent visual guides to 

understanding the spatial distribution of the land use and land cover of a region. 

Furthermore, they can be used to calculate the actual spatial extent of different land 

classes at that point in time. However, a single land-use map may not be enough to 

identify areas where change is taking place. To see what changes have taken place to 

the landscape, it becomes necessary to have at least two land cover maps of a region at 

two points in time. Therefore, the procedure of „Change Detection‟ utilizes two or more 

such thematic images belong to different periods to track the changes that have taken 

place in the study region over the length of that period. This allows us to assess which 

land classes are gained, losses and remained the same over the period of time.  

 

1. Import the thematic images in SAGA via the Load button. Navigate to the folder 

containing the tutorial data and change the file type to „All Files‟. Select the tiff files 

named „time1‟ and „time2‟, and click „Open‟.  
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Select the image „time1‟ in the list under tab section, and click on the tab on the right. 

This displays the metadata of the image file. You will see that the „Value Type‟ is 

„unsigned 1-byte integer‟ and the values range from 1 to 6, this means that there are 6 

land classes in this image.  

 

 
 

Double click on the images to open them. They will appear in shades of grey. This is 

because the class numbers are being treated as pixel DN values. However, that is not 

the case as this is a thematic image and each number represents a unique land class. We 
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will use the lookup table that accompanies the .tif images to designate the appropriate 

class names. 

 

 
 

Click the tab and change the „Colors‟ type from „Graduated Color‟ to look up table.‟ 
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Click on table 

 

 
 

Click on add to make the number of classes 6 

 

 
 

Now change minimum and maximum as follows 
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Look at the  tab to see which land class each colour indicates. It will look 

like this: 
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Overlay the „time2‟ image on the „time1‟ image. Turn it on and off via the „Maps‟ tabs by 

double-clicking on it. This way, we can visually gauge the gains or losses of the land 

classes over the decade. Or by turning on and off the “ show at all scales” option in 

Display tab of Settings. 

 

 
 

The advantage of a georeferenced map over an ordinary map is that spatial 

measurements can be carried out on them easily. Let us take a look at the distribution of 

classes in the map using a histogram (Go to the Data tab → select the Land use Map → 

Right-click → Histogram). This will create a histogram of the classes in the current 

image. Do this for both images and place them side by side.  
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These histograms give us an idea of the relative distribution of classes within each 

image. However, to compare the land class distribution across images we need to have 

a single histogram containing all the class values. This can be done by converting the 

histograms into tables and then joining them.  

 

Question 1: Which land class got converted to Grassland in the above region?  

Question 2: Is there any other part of Pune that has expanded significantly? 

 

These histograms give us an idea of the relative distribution of classes within each 

image. However, to compare the land class distribution across images we need to have 

a single histogram containing all the class values. This can be done by converting the 

histograms into tables and then joining them.  

 

Select the „Histogram map of time1‟ and then click on the „Convert to Table‟ button in 

the toolbar above. Do this for the „time2‟ window as well  
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Two tables will appear in the Data tab list. Double-click on them to open. If the column 

is too small, expand it by holding left mouse bottom and dragging the border between 

two columns.  

 

 
 

The field titled „AREA‟ describes the area of each land class in square metres. This 

becomes inconvenient at small scale maps (Those maps cover large areas, where we 

deal with hundreds or thousands of square kilometres). The conversion of area can be 

done by using „table calculator tool‟ with a conversion parameter „1 m2=1/1,000,000 

km2‟, open the table calculator (Geoprocessing → Table → Calculus → Field 

Calculator).  
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Set the window entries as shown above. They are explained below.  

 

>>Table: This is the name of the table for which the calculation has to be done. From the 

dropdown menu select „01. Histogram: time1‟.  

Field Name: If the entry „Field‟ is „[not set]‟ then this will the name of the new field. We 

will call the new field „Area_sqkm‟, type it over field name.  

 

Field: This decides which field the results will be placed in. Select one from the 

dropdown menu. If it is „[not set]‟ it will create a new field titled by the „Field Name‟ 

entry. This time we will keep it as „[not set]‟.  
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Formula: This is the calculation to be performed on „AREA‟ field which is third on table 

(f1, f2, f3… are being the first, second, third…etc fields). Change the default formula to 

„f2/1000000‟ since we are converting „AREA‟ from square metres to square kilometres.  

 

Result: This points to which table the result will be placed in. „[create]‟ will create a new 

table. Keep this as „[not set]‟ to append the result to the current table.  

Now click on „okay‟ to finish. 

  

16. Open the table „01. Histogram: time1‟ again. The new field will be seen replacing the 

old one. Repeat the steps for the table „02. Histogram: time2‟ 

 

 
 

However, since our area is small, we will keep the area in sq km 

 

We now open „Geoprocessing → Tables → Tools → Join Attributes from a Table‟. Set 

the „Table „entry as „01. Histogram: time1‟ and the „Join Table‟ entry as „02. Histogram: 

time2‟. The Identifiers are the fields to be used as the common link. Set them both to 

„NAME‟. To create a new table select „[create]‟ from the „Result‟ dropdown menu. Now 

click on „Okay‟.  
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The resulting table will have fields from both tables. We can now create a histogram 

comparing the areas of the two images. Right-click on the table and select „Diagram‟.  
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In the Properties window, change the „Display Type‟ to „Bars‟ and the „Label‟ value to 

„NAME‟. From the „Attributes‟ section, check the options for „Area (time1)‟ and „Area 

(time2)‟. You can change the colors if you like. Click „Okay‟. The resulting graph will 

look like below:  
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Here the histogram shows the increase or decrease in area of each class over a decade.  

Question 3: Which class shows the highest increase? 
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